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Payroll Settings  
Once you have turned on payroll and set up the business details you can access the payroll settings. The                   

payroll settings allow you to configure the main setup for your payroll. 

 

You can view all your main payroll settings by selecting > Employees Tab > Payroll Settings: 

 

 

 

The main categories under payroll settings are: 

 

Business Settings 

Pay Run Settings 

Business Management 

Pay Conditions 

Advanced 

 

Under each of these categories you will have the ability to configure the settings for each feature.  

Business Settings 

Payment Files Settings 
This section has 2 components - ​ABA Files​ and ​BPAY Files 

 

From the “Payroll Settings” menu, select “Payment Files” 
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ABA FILES  
 
An ABA file is a file that is used by all major Australian financial institutions to specify payments to be                    

made from one bank account to one or more bank accounts. 

 

The most common way for employers to pay employees is via an ABA file which is automatically                 

generated by their payroll software. Once you have your ABA file, it’s usually a simple matter of                 

uploading it to your business internet banking portal and authorising the payments. 

 

Setting up your business to generate an ABA file 

Before you can generate an ABA file, you need to first setup the ABA settings for your business using the                    

following steps: 

 

From the ABA Settings File tab > Click “Add” to create a new set of ABA settings for your business. You                     

are also allowed to set up multiple ABA files to pay employees from but, as a minimum, you should set                    

up one account. 

 

What are each of the ABA settings for? 

The table below provides more information on the purpose of each of the ABA settings: 

 
Setting 

 
Required 

 
Description 

BSB Number YES The BSB number of the account that payroll payments will          
be made from. 
 

Account Number YES The Account number of the account that payroll payments         
will be made from. 
 

Account Name YES The Account Name of the account that payroll payments        
will be made from. 
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Financial Institution  
Code 

YES The official 3 letter abbreviation of the financial institution         
that the bank account that payroll payments will be made          
from is registered with. e.g. the official Westpac code is          
WBC. 

 
Lodgement Reference 

 
YES 

 
The description of the payroll payment that will appear on          
the employee’s bank statement. e.g. “Payroll” or “Weekly       
wages”. You can also then choose to append (a) pay period          
end date, (b) pay date or (c) employee Id. 
 

Name Of User   
Supplying File 

YES This is the name of the user or business that is creating the             
ABA file. The most common value is the business name. 
 

APCA Number YES This is a 6 digit number provided by your bank. If you’re            
not sure what this number is, you’ll need to contact your          
bank. It’s often listed on their website and for some banks          
such as the ANZ you can provide any 6 digit number (such           
as 000000). 
 

Include Self Balancing   
Transaction 

NO Selecting this option adds an additional “Self balancing”       
transaction to the end of the ABA file which is required by           
some financial institutions when generating the ABA files.        
You’ll need to check with your financial institution to        
determine if you’ll need to select this option (it’s often         
available on their website). If you choose Yes, you can also          
enter a reference and then choose to append (a) nothing,         
(b) pay period end date, (c) pay date or (d) pay run Id. 
 

Merge multiple  
payments for the same    
account into a single    
transaction 

NO Select this option if your financial institution requires that        
only a single transaction be made per bank account within         
the one ABA file. This is occasionally required if you have          
spouses that have their pay paid to the same bank          
account, or an employee has multiple payments going to        
the same bank account. In this case, certain financial         
institutions require that those payments be merged into a         
single transaction. 

  

Once you’ve completed the ABA details click “Save” and you will now be able to generate ABA files from                   

within your pay runs. 

 

Generating ABA files 

You can generate ABA files using the following steps: 

 

After you have finalised a pay run, click the “Download Payment File” button > “Download ABA”: 
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If you only have one set of ABA setting, your ABA file will download automatically. 

 

If you have multiple ABA settings you are able to select which ABA settings to use by selecting the 

“Payment File Settings” button first: 
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Once you’ve selected the correct ABA file, click on “Save”. 

 

We will remember which ABA settings you last used to generate your ABA file and will automatically                 

select it for next time. 

 

 

BPAY FILES 
 
BPAY files can be used to make multiple BPAY payments on behalf of your employees via internet 

banking. You can set up more than one BPAY file then choose which file should be used for each pay 

schedule. 

 

Employees are able to choose whether they want a portion of their net pay to go towards paying bills. 

To do this, they would set up the BPAY account via their Bank Accounts screen. Alternatively, you can do 

this on their behalf. 

 

Setting up your business to generate a BPAY file 

To set up a BPAY file, from your dashboard screen go to Payroll Settings > Payment Files > "BPAY File                    

Settings" tab, then click on "Add" and select the appropriate financial institution. The steps used to                

complete the file setup varies depending on the financial institution chosen. Details are found below.  

 

Please note: ​At this stage, we only support BPAY file formats for the following financial institutions: 

● National Australia Bank (NAB); 

● Commonwealth Bank of Australia (CBA); 

● Westpac; and 

● ANZ. 

NAB 

Enter the following information: 

1. BSB Number; 

2. Account Number; 

3. Financial Institution Code = NAB; 

4. Customer Id; then 

5. Click "Save". 
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CBA 

Enter the following information: 

1. BSB Number; 

2. Account Number; 

3. Financial Institution Code = CBA; then 

4. Click "Save". 
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Westpac 

There is no specific file format for Westpac, so once you select 'Westpac' from the dropdown list, all you                   

then need to do is click on "Save".  

 

ANZ 

Enter the following information: 

1. BSB Number; 

2. Account Number; 

3. Financial Institution Code = ANZ; then 

4. Click "Save". 

 

Generating BPAY files 

You can generate BPAY files using the following steps: 

 

After you have finalised a pay run, click the “Download Payment File” button > “Download BPAY File”: 

 

Once a pay run has been finalised, click on "Download Payment File" and select to either download the                  

BPAY file only or download a zip file with both the ABA and BPAY files. 
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The BPAY file will then download and you can then import this via online banking.  

If BPAY accounts have been set up for employees but the business has not set up their BPAY file format,                    

the following warning will appear when you click on the "Download Payment File" button.  

 

 
 

 

ATO Settings 
The ATO Settings page has 2 tabs: ATO Supplier Settings and Electronic Lodgement & STP: 
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ATO Supplier Settings​: This is where you can configure the information that will be used when                

generating reports that will be submitted to the ATO. This section allows you to enter the following                 

information: 

 

- ABN 

- Branch Number 

- Name  

- Address Line 1  

- Address Line 2 

- Suburb  

- Contact Name  

- Signatory Name 

- Phone Number 

- Fax Number 

 

An additional setting on this screen is: 

● “Is this employer exempt from FBT under section 57A of the FBTAA 1986?” This setting defaults                

to “No”. You can change this to “Yes” if this applies to your business. 

 

All fields are mandatory, apart from "Branch Number", "Address Line 2", “Signatory Name” and "Fax               

Number". 

A handy feature in this screen is the ability to "Copy from Business Settings". If you click this button (to                    

the right of the "Save" button), it will populate the relevant fields from the information entered in your                  

Business Details.  
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Electronic Lodgement & STP​: ​This is where you can enable your payroll file for electronic lodgement to                 

the ATO so that you can lodge Tax File Declarations and Payment Summaries electronically directly from                

the software.  

 

 

 

This is also where you can enable the payroll file for electronic lodgement for Single Touch Payroll                 

reporting.  

 

 

Pay Slips 
 

Pay Slips can be configured via the Pay Slip settings.  

 

You have the ability to upload a company logo which will be visible on all pay slips. 

 

Select > Pay Slips > Choose a logo > Select File > Confirm upload (we recommend dimensions of no larger  

than 150px by 350px) 
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You can also configure the settings by selecting what information you would like visible on the pay slips.                  

Once you are happy with your settings simply select Save. 
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Employing Entities 
If your business employs staff using more than one employing entity, you can setup the additional                

employing entities via this setting.  

 

                 

 

The "Employing Entities" section allows you to enter the following information: 

 

- Name 

- ABN 

- Address Line 1  

- Address Line 2 

- Suburb  

- Contact Name  

- Contact Phone Number 

- Contact Fax Number 

- Contact Email Address 

- Signatory Name 

- External Id 

 

All are required fields apart from “Signatory Name”, "Contact Fax Number", "Address Line 2" and               

“External Id”. 

 

Additional settings on this screen include: 

 

(a) Choose a pay slip logo: You can upload a logo if you want a different one for this employing                   

entity to appear on the employee’s pay slip. 

(b) “Is this employer exempt from FBT under section 57A of the FBTAA 1986?” This setting defaults                

to “No”. You can change this to “Yes” if this applies to your business. 
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(c) Enable Electronic Lodgement: Once you save the Employing Entity settings, you will then see this               

option that allows you to electronically lodge ATO paperwork directly from KeyPay. To enable              

follow the instructions provided and then click on “Enable Electronic Lodgement”. 

Chart of Accounts 
With the QuickBooks + KeyPay online integration, once you import your chart of accounts the journals                

will be exported directly to QuickBooks each time you finalise a pay run. 

 

To set up the Chart of Accounts: 

 

Click on “Chart Of Accounts” > “Import Accounts”:  

 

 

You will then be redirected to your available accounts: 

 

 

 

Select each account you wish to import/map into the Chart of Accounts. Once you are happy with your                  

selected accounts, click on “Save Accounts List”. 
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Once saved you will be taken back to the Chart of Accounts screen to map your QuickBooks Online                  

Accounts to your Payroll Accounts. 

 

Select > Default Accounts and begin mapping each pay component.  

 

For each journal transaction type that you want classes and locations to be assigned to, click the "Split                  

by location" option against each transaction type. In this case, we're going to split the wages expenses                 

by location:  

 

 

You also have the option to map Pay Categories, Deductions, Expense Categories, Employer Liability              

Categories and Locations to specific GL accounts. 

 

 

 

Once you are happy with your mapped accounts, click on “Save”. 
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Opening Balances 
The Opening Balances settings screen allows the user to configure the initial financial year for your                

business as well as import/export the opening balances for employees in the business. This is beneficial                

for businesses who have used a different payroll system throughout the financial year and want to                

consolidate all their FY data so staff only receive one payment summary. Additionally, this setting allows                

you to transfer YTD leave balances for each employee across to KeyPay. 

 

To access Opening Balances, go to Payroll Settings, then Opening Balances. 

 

The following page will be displayed: 

 

 

The initial financial year for the company may be adjusted here. This is the year that the opening                  

balances for Gross/PAYG/Super will apply. (Leave balances are simply adjusted by the opening balance              

specified). 

 

Note that opening balances have an effective 'Date Paid' of 2nd of July in the financial year that you                   

specify. To include opening balances in reports, the report period should be run from 1/7 of the initial                  

financial year. 

 

Additional Functions:  

● To Import the opening balances, click on the Import button 

● To Export the opening balances to a CSV or Excel file, click the Export button 

● To configure the opening balances for a specific employee, open up the employee file and then                
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go to the Opening Balances section. 

Pay Run Settings 

Pay Schedules 
Pay Schedules are created to set up one or more pay runs. A pay schedule will already be created based                    

on the pay run frequency you chose when first setting up your business details. You can always change                  

the name and other settings of this default pay run. 

 

 

Pay schedule settings include: 

- Name:​ The name of the pay run will be referenced when creating a pay run. 

- Frequency​: The options available are weekly, fortnightly or monthly. ​(NB- this dictates the 

calculation of the employees' PAYG so ensure you select the correct frequency.) 

- Included employees: ​Select which employees you would like to populate the pay run when it’s               

created. The options include - None; Employees with this pay schedule as their default; and               

Employees with ​timesheets in the following locations (then select the required location/s)  

- Pay Run Warnings: ​By default, all triggered system warnings will be displayed in the pay run.                

There may, however, be some pay run warnings that are of no relevance to a particular pay                 

schedule and so you would prefer they are not displayed in the pay run. This setting allows you                  

to configure the warnings you ​DO want displayed in the pay run. Clicking on ​"here" ​will open the                  

context panel. ​Deselect the warnings you do not want appearing in the pay run. A full list and                  

explanation of each pay run warning can be found ​here​. 
- PAYG Payments​: ​Select this option if you want the ABA file for that pay run to include the PAYG                   
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amount to be transmitted to the ATO at the time of the pay run. 

- Pay Run Automation​: This setting allows you to choose what components of a pay run you want 

automated, that is run in the background automatically, and what components are to be 

processed manually. If the pay run is to be processed manually from start to end then no setting 

needs to change as manual processing is the default setting. Instructions on how to set up an 

automated pay schedule can be found ​here​.  

 

NOTE ​- If you select Monthly as the frequency for your Pay Schedule you will be given the ‘​Monthly                   

Payment Mode’​  option this will calculate monthly hours based on an annual average.  

 

All settings are required except for the PAYG setting - do not tick this if you do not wish to pay PAYG via                       

the ABA file as part of the pay run process.  

 

Automating a Pay Schedule 
 
To set up an automated pay schedule, go to Payroll Settings > Pay Schedules, and then click on the 
applicable pay schedule to view the pay schedule settings. Click on ​"here"​ to commence the setup 
wizard: 
 

 
 
There are 4 steps to automating a pay schedule -  
 

1. Auto Pay Schedule Details 
2. Warnings and Notifications 
3. Pay Run Finalisation Options 
4. Summary 

 
Click ​here ​for instructions on how to set this up.  
 

Locations 
Employees are assigned to locations so that their wages can be reported against them and labour costs 

can be determined accordingly. 

 

You can import existing locations from QuickBooks to set up the locations within KeyPay: 
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Within each location setting, you can: 

 

 

 

1. Assign a State/Territory - particularly important if you have locations in more than one state.               

This will ensure the payroll tax report correctly assigns wages to the correct State/Territory.  

2. Assign a class to a location (this will then feed through to the payroll journal). 

3. Make the location available to all staff automatically - particularly relevant when it comes to               

rostering and timesheets. 

4. If you are using an external system to generate employee timesheets, you can add the Id/Code                

of the location used by the that system so that it picks up the correct location when importing                  
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the timesheets. 

5. Whether or not you want sub-locations to report to this location - when this is enabled, reports                 

will not split data into sub-locations. Rather, all report data will be "rolled up" and included in                 

this location. 

Pay Categories 
Pay Categories are used to create the different pay components that make up an employee’s pay. When                 

you create a new business, a number of common pay categories are automatically added by default,                

however you are able to delete and/or modify these and create new ones that match your business                 

needs. 

  

 

Create a Pay Category 

  

You can create a Pay Category by following these steps: 

 

 

 

This will redirect you to the following page:  
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Clicking on “Add” will open the new Pay Category pop up box. Type the name you want the Pay Category                    

to be called and click on “Add”. 

 

The pay category will be saved and you can then begin to adjust further settings: 

 

 

 

- Units​: is the pay category an hourly, annual, fixed or daily unit? Choose hourly where the pay                 

category is to be paid based on hours worked; choose annual if you are setting up salaried                 

employees; choose fixed for allowances; choose daily if you are setting up day rates. 

- Super Rate​: by default, the figure here will be as per the current legislated amount. You can                 

override this figure as per your circumstance. For example, if you are creating an overtime pay                

category that super is not paid on, you can change the figure to ‘0’. 

- Rate Loading​: This is loading that is applied on top of the base rate that the pay category is                   

linked to. For example, for a casual employee earning a 25% casual loading, the rate loading will                 

be specified as 25%. So where the base hourly rate is $20, when adding the casual loading, the                  

casual rate will be $25 per hour. ​N.B. The Rate Loading only applies to hourly unit pay                 

categories.   

- Penalty Loading​: This option is available for linked pay categories - this is detailed further below. 

- PAYG Exempt​: Tick the checkbox if the pay category is non-taxable.  

- Accrues Leave​: Tick the checkbox if you want leave to accrue on this pay category. ​N.B. You                 
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cannot accrue leave on a fixed unit pay category.   

- Payroll Tax Exempt​: Tick the checkbox if the pay category does not incur payroll tax.  

- Exclude from W1 in journals​: Tick the checkbox if earnings against this pay category is not to be                  

classified as W1. 

- External Id​: ​If you are using an external system to generate employee timesheets that includes               

the pay categories, you can add the pay category Id/Code in this field so that the correct pay                  

category is assigned when importing the timesheets into the pay run. 

- Payment Summary Classification​: Keep as ‘Default’ unless the pay category is ​not to be              

displayed in the ‘Gross Payments’ field of the payment summary.  

- Rate Precision​: Here you have the option of setting how many decimal places the dollar value of                 

the pay category should be. Regardless of this setting, you can change it in the pay run also.  

 

Once you have completed setting up the Pay Category, click on ‘Save’. 

 

Linking Pay Categories 

  

Linked pay categories can be used to easily manage employee pay rates by automatically calculating               

linked rates through the loading and penalty rate multiplier settings. For example, you could create a                

pay category called “Weekday - Ordinary Hours” and then create a linked pay category called “Saturday”                

which has a 25% penalty loading on “Weekday - Ordinary Hours”. Because the “Saturday” pay category                

is linked to “Weekday - Ordinary Hours”, you then only need to specify the hourly rate for “Weekday -                   

Ordinary Hours” against the employee and the linked “Saturday” hourly rate will automatically be              

calculated. 

 

To create a linked pay category as per the above example, click on the "Add Linked Category" button in                   

the bottom right hand corner of the chosen pay category: 

 

 

A pop up box will appear where you will type the name of the linked pay category. Then click on “Add”.  

 

N.B. You have the opportunity to delete the linked pay category before actually using it. To do this, move                   

your cursor towards the end and you will see the delete action button . Click on this to delete the                    

new linked pay category. 
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Once the linked pay category is saved, complete the additional settings as per the instructions above.                

Using the “Saturday” example above, you can see the 25% penalty has been entered in the ‘Penalty                 

Loading’ field: 

 

 

 

Once you have completed all the linked pay category settings, click on “Save”. 

Leave Categories 
Leave Categories are used to create the different leave components that an employee is entitled to,                

whether paid or unpaid.  

 

When you create a new business, a number of common leave categories are automatically added by                

default, however you are able to delete and/or modify these and create new ones that match your                 

business needs. 

 

To access the Leave Category settings, go to the Payroll Settings tab and then click on “Leave Categories” 

located under the Pay Run Settings heading. Here you can enter the date that the leave year should start 

and configure whether or not the employees require notes when submitting a leave request - 
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From this screen you can add a new leave category by clicking on “Add” (located on the top right hand                    

side of the screen). You will then be presented with the following screen: 
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Complete the leave category settings as follows: 

 

- Name​: Enter the name of the leave category 

- External Id​: ​If you are using an external system to generate employee timesheets that includes               

the leave categories, you can add the leave category Id/Code in this field so that the correct                 

leave category is assigned when importing the timesheets into the pay run. 

- Leave Loading​: if leave loading applies when the employee takes this leave then the loading               

percentage should be specified here. For example, if an employee receives 17.5% leave loading              

when taking annual leave, enter 17.5 in this field. This will then automatically calculate the leave                

loading in the pay run. 

- Leave Category Type​:  Select either 'Standard' or 'Long Service Leave' from the drop down.  

- Employee Leave Balance​: Select either 'Tracked' or 'Not tracked' from the drop down.  

‘Not tracked’ is usually selected for leave types that don’t accrue in the usual way (e.g. leave                 

without pay) and so does not make sense for an employee to have a 'balance'.  

If you select ‘Tracked’, the following settings will appear: 

(a) Automatically Accrues​: tick the checkbox if the leave type has automatic accruals, for eg              

annual leave or personal leave.  

(b) Exclude from termination payout​: tick the checkbox if the leave type is not paid out               

upon termination. 

(c) Hide accruals from pay slips​: tick the checkbox if you don’t want employees to see the                

leave hours they have accrued in the pay run on their pay slip. 

(d) Hide balances from pay slips and in employee portal​: ​tick the checkbox if you don’t               

want employees to see their leave balance on their pay slip and employee portal.  

(e) Hide leave category name from employee view: ​tick the checkbox if you don’t want              

employees to see the name of the leave category from the employee’s calendar view.              

The employee will only see which employee is on leave, but not the type of leave they                 

are taking.  

 

- Standard Allowance​: This setting appears if you have ticked the ‘Automatically Accrues’ setting             

and is where you enter the accrual rate. The accrual rate can be set on a `Hours per hour                   

worked’ or `Hours per pay run’ basis.  

You can enter the accrual rate directly in the field or you can click on the calculator to assist in                    

determining the correct accrual rate. The following pop up will appear and the example              

provided shows the accrual rate per hour worked for 4 weeks of annual leave: 

 

26 



 

 

- Payment Setup​: This determines whether the employee is paid for the leave taken and the pay                

category that is assigned when leave is taken. Select from one of the following options:  

 

○ Basic​: When an employee does not use timesheets (specifically, if an employee’s            

timesheet setting = Do not use timesheets OR Use timesheets for exceptions only), the              

employee's leave balance will be reduced. When an employee is using timesheets to             

submit all time worked, an earnings line will be created and the leave balance will be                

reduced. 

○ Don't pay for the leave taken​: When an employee does not use timesheets (ie, is set up                 

as autopay), a negative earnings line will be added to reduce the earnings for the               

employee. When an employee is using timesheets to submit all time worked, no             

earnings line will be created. 

○ Report the earnings for the leave taken against another pay category​: When wanting             

to report payments for leave taken in a separate pay category (for reporting/journaling             

purposes), select this option. The earnings related to the leave taken will be assigned              

against the specified pay category instead of the employee's primary pay category.            

When this alternative is selected, the option will be given to use the rate of pay from the                  

employee's primary pay category. If the leave rate of pay differs to the employee’s base               

rate of pay then untick this option.  
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○ Custom​: For advanced users only, this option allows the user to deduct hours from an               

arbitrary pay category and transfer them to another arbitrary pay category when leave             

is taken. 

 

 

To change the setting of an existing Leave Category, simply click on the leave category name. This will                  

then expand to display the settings. Make any relevant changes and click on “Save”.  

Deduction Categories 
Deduction categories are used to define the different types of deductions applicable in the business.               

Once deduction categories are set up, they can then be assigned against an employee. 

 

When you create a new business, a number of standard deduction categories are automatically added               

by default, however you are able to delete and/or modify these and create new ones that match your                  

business needs. 

 

To add a new deduction category, click on “Add” and complete the following settings: 

 

- Name​: Enter the name of the deduction category. As this name will appear on pay slips, ensure                 

it is something employees will be familiar with. 

- Deduction Type​:  Select from either Pre-Tax or Post-Tax deduction.  

- Impact on SGC Calculations​: ​This option will only appear if the deduction is pre-tax​. Select from                

either (a) No impact; (b) Reduce Ordinary Times Earnings (OTE) or (c) Reduce OTE and offsets                

SGC contribution (if allocated to a super fund). Options (b) and (c) will affect SGC calculations as                 
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follows: 

 

  

- External Id​: If you are using an external system to manage deductions, ​you can add the                

deduction category Id/Code in this field so that the correct deduction is assigned to the               

employee when importing into the pay run. 

- Payment Summary Classification​: Keep this setting to ‘Default’ unless the other 2 options apply,              

being ‘Union or Professional Association Fees’ (any amounts you pay to unions or professional              

associations on behalf of your employees) or ‘Workplace Giving’ (any amounts you pay to              

deductible gift recipients on behalf of your employees). What you choose here will determine              

where the deduction amount is specified in the employee’s payment summary. 

 

Once all settings are complete, click ‘Save’.  

 

To change the setting of an existing Deduction Category, simply click on the deduction category name.                

This will then expand to display the settings. Make any relevant changes and click on “Save”.  
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Expense Categories 
Expense categories define the different types of out-of-pocket claimable expenses your employees incur 

through the course of their employment. You can process employee expenses as part of the normal pay 

run (or in a separate pay run) that will then generate an ABA file you can then upload through your bank 

portal. This is a time-saving method of managing the reimbursement of employee expenses.  

 

Expense reimbursements are not considered as earnings and so are not included in net or gross amounts 

calculated in pay runs. Additionally, they are not included in payment summaries generated at the end of 

the financial year. 

 

To add a new expense category, click on “Add” and complete the following settings: 

 

- Name​: Enter the name of the expense category. As this name will appear on pay slips and the                  

employee portal, ensure it is something employees will easily understand. 

- External Id​: If you are using an external system to manage expenses, ​you can add the expense                 

category Id/Code in this field so that the correct expense is assigned to the employee when                

importing into the pay run. 

- Tax Code​: If you have activated GST, a drop down of the tax codes setup in QBO will appear to                    

select. By assigning a tax code, the GST will be calculated accordingly and posted in the pay run                  

journal. 

 

Once all settings are complete, click ‘Save’.  

 

To change the setting of an existing Expense Category, simply click on the expense category name. This                 

will then expand to display the settings. Make any relevant changes and click on “Save”.  

Employer Liability Categories 
You can set up employer liability categories to track liabilities on a per employee basis.  

 

To add a new employer liability category, click on “Add” and complete the following settings: 

 

- Name​: Enter the name of the employer liability category. 

- External Id​: If you are using an external system to manage employer liabilities, ​you can add the                 

category Id/Code in this field so that the correct employer liability is assigned to the employee                

when importing into the pay run. 

- Hide from pay slips​: Tick this checkbox if you don’t want the employer liability category               

appearing on the employee’s pay slip. For example, you could be tracking an internal liability               

such as workers compensation that the employee doesn’t need to see. Alternatively, you could              

be tracking portable long service leave and want this viewable on the employee’s pay slip.  
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- Show total payments in pay slips​: This option will only appear if you haven’t ticked the above                 

setting. Ticking this checkbox will display the total cumulative value of the liability category on               

their pay slip. 

- Include in shift cost calculations​: This is relevant if using pay condition rule sets and allows the                 

employer liability cost to be included as part of the shift cost.  

 

Once all settings are complete, click ‘Save’.  

 

To change the setting of an existing Employer Liability Category, simply click on the liability category                

name. This will then expand to display the settings. Make any relevant changes and click on “Save”.  

Qualifications 
Qualifications are a useful way of managing employee certifications, police checks and expiring             

qualifications just to name a few. Creating qualification categories allows you to then assign against an                

employee profile, add relevant documents to each qualification and monitor when a qualification is due               

to expire. You can also attach required qualifications to rostered shifts and ensure only qualified               

employees work those shifts.  

 

To add a new Qualification, click on “Add” and enter the name of the qualification. 

Business Management 

Timesheets 
This section is relevant to a business that requires their employees to record start and finish times using                  

timesheets. The timesheets can then be used to import into the pay run and/or be used for record                  

keeping purposes. 

 

To activate Timesheets, click on “Enable”. You will then be presented with the following timesheet               

settings: 

 

- Require start/stop times when entering timesheets​: If this is unchecked, employees will have             

the option of entering the number of hours worked each day as well as start/stop times. If pay                  

conditions or awards are in use, start/stop times should be required for proper interpretation. 

- Require a work type when entering timesheets​: If this is checked, employees must enter a work                

type when submitting a timesheet. If no work types are set up or this is not compulsory ensure it                   

remains unchecked. 

- Require a location when entering timesheets​: If this is checked, employees must enter a              

location when submitting a timesheet. If this is unchecked and the employee does not select a                
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location, it will assign the timesheet to the employee’s primary location. 

- Include all timesheet notes in the pay run​: If this is checked, any notes entered by employees                 

and/or manager in the timesheet will appear in the pay run. (You can determine whether you                

want these notes then appeared on pay slips via the Pay Slips settings).  

- Notify employees when their timesheets are rejected​: Managers have the ability of rejecting             

timesheets submitted by employees. If this setting is checked, employees will receive a             

notification informing them as such.  

- Managers can create timesheets for all employees that aren't enabled for timesheets​: If an              

employee is not set up to use timesheet, this setting will allow a manager to submit a timesheet                  

on behalf of that employee without the need to enable timesheets for that employee.  

 

The above settings will apply when creating timesheets through the business portal, employee portal,              

WorkZone and the web kiosk.  

Import Employees 
Please refer to the section “Setting up Employees”. 

Manage Users 
This section is where full access users are able to provide access to other users. There are 2 tabs on this                     

screen - ‘Manage Users’ and ‘Manage Employee Groups’. 

 

There are 2 types of access levels: 

 

(a) Full access​: This gives the user access to ALL areas of payroll. 

(b) Restricted access​: This type of access is commonly given to managers. Here you can select what                

specific areas you want the user to access and restrict by employee group and/or location. You                

can also give the restricted access user reporting access.  

 

Manage Users tab 

 

To create a new user, click on “Add” (located on the top right hand side of the screen) in the Manage                     

Users tab. Then: 

 

1. Enter the user’s email address; 

2. Enter the user’s full name; 

3. Select the access level for that user by clicking on either ‘Full Access’ or ‘Restricted Access’; 

4. If ‘Full Access’ is selected, then click ‘Save’. The user will then receive 2 emails with instructions                 

on creating a password and logging into payroll. 

5. If ‘Restricted Access’ is selected, further settings will be activated for you to complete. The 3                
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sub-settings are: 

 

● Employee access​: choose an employee or group of employees the user can access. To              

create an employee group, click on ‘Create’ for the context panel to appear. From there               

enter a name for the employee group and complete the criteria required to make up               

this group. You can include more than one criteria by clicking on “Add another criteria”               

and then choose whether the multiple criteria must match ALL or ANY of the criteria               

selected. You can also create employee groups from the ‘Manage Employee Groups’            

tab, which is explained further below.  

● Location​: choose a location(s) the user can access. You can choose the criteria location              

or location and any sub-locations (this means that the user will have access to all               

sub-locations sitting underneath the location selected). 

● Reporting​: provide the user with access to some or all reports.  

 

6. The different permissions relating to Employee access and Location are as follows: 

 

● Approve Leave Requests​: Permissions of ‘View Leave Requests’ and ‘Create Leave           

Requests’ as well as the ability to approve requests. 

● Create Leave Requests​: Can only create leave requests but not approve or view leave              

requests. 

● View Leave Requests​: Can only view leave requests (read-only). 

● Approve Employee Expenses​: Permissions of ‘View Employee Expenses’ and ‘Create          

Employee Expenses’ as well as the ability to approve requests. 

● Create Employee Expenses​: Can only submit expense requests for other employees but            

not approve or view expense requests. 

● View Employee Expenses​: Can only view expenses (read-only). 

● Manage Employee Documents​: Can add employee documents. 

● View Employee Documents​: Can only view employee documents (read-only). 

● Manage Employee Qualifications​: Can add/allocate Employee Qualifications. 

● View Employee Qualifications​: Can only view Employee Qualifications (read-only). 

● Manage Employee Rosters​: Users can create, edit, delete and publish shifts as well as              

add employee unavailability.  

● View Employee Rosters​: Users can only view the roster (read-only). 

● Approve Timesheets​: Permissions of ‘Create Timesheets’ plus ability to approve          

timesheets. 

● Create Timesheets​: Users can create and import timesheets for other employees. They            

can also edit and delete timesheets submitted by employees. 

● View Shift Costs​: Users can see the shift and/or timesheet costs.  

● Create Tasks​: Users can view and create pay run tasks. 

● Initiate Self Setup​: Users can start the employee self set up process for new employees. 

 

You can select one or a combination of these permissions to assign to a user. 
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Manage Employee Groups tab 

 

You can also set up Employee Groups to create segments/groups of employees through this tab. To                

create an employee group click on “Create” (located on the top right hand side). The context panel will                  

appear where you can then follow the above instructions on creating a group. 

 

From this screen, you can view the employees who form part of an employee group. To do this, click on                    

the ‘x matching employees’ text to the right of the employee group name.  

Employee Portal Settings 
This section is where you configure the employee permissions and areas you want to activate for 

employees to access when they log in to the employee portal. This can be done from the ‘Settings’ tab. 

 

The ‘Access’ tab is where you can grant or revoke access - this can be done for one employee or in bulk. 

Employee Portal access is not automatically granted to employees - this must be done through here or 

from within the employee file > Employee Portal Access. Once access has been granted to an employee, 

they will receive 2 emails with their login details and instructions on setting up a password. 

 

N.B. Employees ​must​ be set up with an email address in order for them to be given access to the 

employee portal.  

 

WorkZone  

 

 

 

If you activate the employee portal, you should also advise staff of the WorkZone app. This smartphone 

app is basically the employee portal on their phone. You can download the app from here: 

 

iOS: ​https://itunes.apple.com/au/app/workzone/id1145223287?mt=8 

Android: ​https://play.google.com/store/apps/details?id=au.com.webscale.workzone.android&hl=en 

 

Time & Attendance 
This section is relevant for businesses requiring staff to clock in and out to capture shift and/or meal 

break data. To enable the settings on this screen, you will need to be subscribed to the ​QuickBooks 

Payroll Advanced ​plan. 
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Businesses need to be logged in to a “kiosk” so that time can then be captured. Each kiosk has it’s own 

unique URL that can be pasted to a browser to activate the clock in/out functionality. 

 

Kiosk Management tab 

 

To create a kiosk, click on “Add Kiosk” and complete the following settings: 

 

1. Name​: Enter the name of the Kiosk - this name should be easily identifiable to others. 

2. Location​: Select a location from the dropdown list.  

3. Time Zone​: Confirm the correct time zone of the location selected in (2) above. 

4. Allow employees to select a higher classification when clocking on​:​ tick this option only if 

employees are attached to employment agreements and work higher duties. They will then be 

able to choose an employment agreement containing a higher rate of pay when clocking in. 

5. Restrict employees to approved locations only​: if this option is ticked then staff can only clock 

in against the locations they are attached to. 

6. Allow employees to apply rostered start/finish times when clocking on/off​: ​This setting is only 

relevant if you are using the Rostering feature​. Ticking this option will allow you to configure 

when a rostered shift start/finish time should be used in lieu of the employee’s clock in/out 

time. For example, you apply the setting “Employees can apply the rostered start time up to ​30 

minutes before their shift is due to start”. An employee is rostered to start at 9am but clocks in 

at 8.38am. As this is within 30 minutes of their rostered start time, the employee can choose to 

record their clock in time as 9am. 

7. Capture photo when clocking on/off​: tick this option if you require employees to take a photo 

when clocking on/off.  

8. Employees must select a work type for their shift​ and ​Employees must select a location for 

their shift​: these settings are determined in the “Timesheets” settings and are locked. Changes 

can only be made from the​ ​“​Timesheets​” screen. 

9. Click on ​‘Save’. 

The kiosk will then appear on your screen as follows: 

 

(a) click on this icon to copy the URL and paste to browser 

(b) click on this icon to launch the kiosk 

(c) click on the ‘x’ to delete the kiosk 

Launching the kiosk takes you to the screen below. From here, employees can enter their employee Id 

and PIN to clock in/out of their shifts and meal breaks. 
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You can create multiple kiosks for different locations within the business.  

Employee Access tab 

From here, you can grant or revoke employee access to the kiosk. This can be done for one employee or 

in bulk. Employee kiosk access is not automatically granted to employees - this must be done through 

here or from within the employee file > Time and Attendance.  

 

Once access has been granted to an employee, they will receive an email containing their employee ID 

and PIN details. If an employee does not have an email address you can set up their PIN through their 

employee profile and communicate that PIN to the employee directly. 

 

Clock Me In 

 

 

Clock Me In is an iPad app (free of charge) that allows you to capture 

clock in/out information in real time. Employees clock in and out from 

the kiosk using their PIN as provided to them from the above 

instructions. 

 

Clock Me In can be downloaded from ​here​.  
 

More information regarding Clock Me In can be found ​here​.  

Subscription 
By default, all QBO users are attached to the “​QuickBooks Payroll Standard” plan and the included 

employees are set out by the QuickBooks plan your are currently on - contact QuickBooks for more 

information. 

 

The second plan available to QBO users is “QuickBooks Payroll Advanced”. The price for the use of                 

Advanced Payroll features is $6.00 per active employee per month. An active employee is one that gets                 

paid during the period of a calendar month. 
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In addition to the features contained within the “Standard” plan, the “Advanced” plan includes: 

 

● Automated Pay Conditions Engine 

● Pre-packaged Modern Awards 

● Time & Attendance Kiosk 

● Employee Rostering 

● Clock Me In (iPad App) 

 

To upgrade to the “QuickBooks Payroll Advanced” plan, click on “View other plans” and then click on                 

“Upgrade”. You will then be upgraded to the Advanced plan and the additional features will be enabled                 

within seconds. Additionally, enter in your credit card details via the “Enter Payment Information” if not                

already supplied. 

 

Please note you can downgrade your plan at any time by clicking on “View other plans” and then clicking                   

on “Downgrade”.  

Documents 
This section allows you to upload documents that can then be shared to ALL employees or a group of                   

employees. Documents such as employee handbooks, company policies, etc are good examples of what              

can be posted here. 

 

To upload a document: Payroll settings tab > Documents > Click on Upload Document - 

  

 

You will then be given the option to Add document > select the required document from the files on                   

your computer.  
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Once the document has been added you will need to configure the following settings:  

● This document is private​: only full access users will be able to see this document. 

● Visible to all employees​: all active employees set up in the payroll system will be able to view                  

this document. 

● Visible to Employee Group​: select the employee Group/s you would like to be able to access the                 

document.  

● Visible to location​: select the location/s you would like to be able to access the document.  

● Requires employee acknowledgement​: ​the acknowledgement process will require the 

employee to click on  the “Acknowledge” button against the applicable document.  

● Send notification to employee​: You can choose to send a notification either (a) immediately or               

(b) schedule for the reminder to be sent on a date specific date. ​Additionally, you can schedule a                  

reminder notification to be sent to employees every 'x' number of days. 
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To edit an existing document: click on the pencil icon next to the document name.  

To delete an existing document: click on the trash bin next to the document name.  
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N.B: Individual employee documents or documents that should only be viewed by one employee              

should not be set up from this section. Rather, they would be uploaded via the employee’s file. 

Public Holidays 
Setting up public holidays is particularly useful when it comes to: 

  

● staff applying for leave (and so not counting the day as a leave day) 

● automating payment of penalties for applicable staff when working a public holiday 

 

Gazetted public holidays are automatically configured in the system. If you need to set up additional                

public holidays, ie regional public holidays, click on the date in the calendar. A popup box will appear as                   

follows: 

 

 

1. The date will pre-populate based on the date you clicked on in the calendar however you can                 

change the date if initially selected incorrectly; 

2. Enter the name of the Public Holiday - this is required and should be clearly identifiable to                 
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employees 

3. Entering a note is optional 

4. Select who the public holiday should apply to. If the public holiday applies to a state(s) then                 

select the relevant states. However, if the public holiday is regional/location based DO NOT              

select a state - rather you would have to select the location it applies to.  

5. Click “Save”.  

 

You can delete a public holiday set up by the user by clicking on the public holiday (whereby the popup                    

will appear) and then clicking on “Delete”. 

  

 

 

Any public holidays set up by the system cannot be deleted. Rather, you will need to untick each state                   

you don’t want that public holiday applied to. N.B. System generated public holidays are identifiable as                

they have “SYSTEM” written on the top right hand side: 
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Rostering 
This section is only applicable if you are on the “QuickBooks Payroll Advanced” plan and will be using the                   

rostering features. 

 

Below is an explanation of the settings: 

 

● Managers can edit roster templates​: Tick this setting if you want restricted users with “Manage               

Rosters” permission to be able to create and/or edit ​roster templates​. If this is not selected, only                 

full access users can create and edit roster templates.  

● Managers can edit roster budgets​: ​Tick this setting if you want restricted users with “Manage               

Rosters” permission to be able to add and/or edit budget amounts in the roster. If this is not                  

selected, only full access users can manage roster budgets. 

● Rostering budget warning %​: If you are using the roster budget, you can enter a figure here that                  

will then be used to show a warning in the roster when rostered wages vs budgeted wages are                  

at or exceeding this percentage amount. 

● Rostering Budget entry​: ​If you are using the roster budget, select from the dropdown whether               

amounts should be entered as a percentage of sales or as amounts entered directly.  

● Employees can decline shifts that have been assigned to them​: Tick this setting to allow staff                

the option of declining a shift (via the platform) once the shift has been published. If an                 

employee declines a shift, it will be unassigned from the employee and will move to the                

unassigned row in the roster.  

● Employees must accept shifts that have been assigned to them​: Tick this setting if it               

compulsory for staff to implicitly accept shifts (via the platform) once the shift has been               

published. When an employee accepts the shift, the status will change from published to              

accepted. 

● Default Shift Action​: If BOTH settings (above) to decline and accept shifts have been switched               

on, this setting will then appear. This setting will configure the default shift action if an                

employee has not actioned the shift within the shift action cut off time. Options are for the shift                  

to be either automatically accepted or declined. 

● Shift Action Cut Off​: If either setting to decline and/or accept shifts has been switched on, this                 

setting will then appear. Enter the number of hours the employee has before the rostered shift                

commences to action the shift. For example, if “12” is entered, this means the employee               

deadline for actioning the shift is 12 hours before the shift commences. 

● Shift Swapping​: To enable Shift Swapping you can select the option - ​Employees can swap shifts                

that have been assigned to them. ​This means that when rostered shifts are published,              

employees can choose to swap the shift with another employee if they cannot work the shift.                

Employees will be provided a dropdown list of "recommended" employees that they can swap              

with. 

● Shift Swap Cut Off: If shift swapping is enabled, the business will need to set a timeframe of                  

when the swap must be actioned prior to the commencement of the shift. If the swapped                
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employee does not action the shift prior to this timeframe, the swap will be cancelled and the                 

shift will revert back to the original employee. 

● Swap Approval​: If shift swapping is enabled, the business must decide the level of approval               

required for swapped shifts. The options are (a) a swapped shift must always be approved by a                 

manager before the swapped employee is assigned the shift in the roster, (b) a swapped shift                

never needs to be approved by a manager and therefore will automatically be reassigned to the                

swapped employee in the roster, or (c) the swapped shift will only need to be approved by the                  

manager when the cost of the swapped shift is higher than the original shift. If either option (a)                  

or (c) is selected, please note that the manager will only need to approve the shift AFTER the                  

employee assigned the swap has accepted the swap. 

● Shift Bidding​: Enabling shift bidding will allow ​managers to assign an open (unassigned) shift to a                

group of employees. The first employee that accepts the shift will then be assigned to the shift                 

and the roster will update accordingly. If shift bidding is enabled, the business will need to set a                  

timeframe of when managers should be notified that a bidding shift is yet to be actioned by the                  

employees. Managers will need to configure their ​My Notifications options to receive the ​email              

notification for - "Email me when a biddable shift has not been accepted by the notification                

cutoff time" 

● Employee Reminders​: If the setting to accept shifts has been switched on, this setting will then                

appear. Configure whether you want employees to receive a reminder notification to accept the              

shift. If yes, then set the number of hours before the shift action cut off time that the                  

notification should be sent. The reminder will be sent out via the method chosen against the                

employee’s rostering notification settings. 

● Custom message for shift notification emails​: Shift notification emails contain default content.            

Here is an example: 

 

If you want to add a tailored message to the shift notification emails, enter the text in this                  

section by clicking on “Edit” > enter the text > click “Apply”.  

● Custom message for shift notification SMS​: SMS shift notifications contain default content. If             

you want to add a tailored message to the SMS, enter the text in the box.  

 

You MUST click “Save” on the bottom of the screen if any configuration or setting changes are made. 

Report Packs 
Report Packs is a very resourceful tool when required to regularly send reports to managers or business                 
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stakeholders or anyone who does not have user access to the payroll system. You can automate the                 

scheduling of reports to recipients on a recurring frequency or at specific times. 

 

 

Add a Report Pack 

 

To set up a Report Pack, click on “Add” (located on the right hand side of the screen) and complete the                     

following details: 

 

● Name​: Enter the name of the report pack. Make sure the name is easily identifiable, especially if                 

you will be setting up various report packs. 

● Period​: Select the ​period from the dropdown list in which you would like the date range report                 

filters to generate (you can however leave this blank if you want to set custom dates instead).  

● Set up a schedule​: This is where you can automate the frequency, date and time you want the                  

report pack sent out. 

● Send out at these times​: In addition to, or instead of setting up a recurring schedule, you can                  

select a specific date and time for the pack to be emailed. You can set up multiple times by                   

clicking on “Add another time”. 

● Reports​: Select the report(s) you want to add to the pack. When selecting a report you will need                  

to ensure the report filter is set up correctly. If you have defined the ‘report period’ in the                  

second step and want to use that date range then tick the “Use Report Pack Period” option. 

● Recipients​: This is where you set up the people who should be receiving the report pack. Enter                 

the email address and name of the person in the relevant field. To add an additional recipient,                 

click on “Add Recipient” and enter the details. 

● Custom Message​: If you want to add custom content to the email the recipients receive and/or                

the ‘from’ email address, you can do this here. Click on “Edit” to enter an alternative ‘from’                 

email address. If you want to edit the custom message of the email, click on “edit” > enter the                   

text > click on “Apply”.  

● Click on “Save” to finalise the report pack settings.  

 

Repeat the above steps if you want to add more report packs. 

 

Report Pack Default Configuration 

 

There are two components here and both are optional: 

 

1. From email address: The system’s default setting for the ‘from’ email address displayed to the               

recipient when they receive the report pack is the email address entered in the “Contact Email                

Address” field within the ​Details ​payroll settings screen. To change this default setting, click on               

the “Configuration” button (located on the top right hand side) and enter the email address.               

Then click on “Save”.   

2. Email custom message​: Similarly, if you want to change the system’s default email content, click               

on the “Configuration” button (located on the top right hand side) and enter the customised               
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content. Then click on “Save”.   

  

Whatever you have entered in this section will become the ‘new’ default settings for report packs. You                 

can tailor these details on a per report pack basis by following the instructions on adding a report pack.  

Pay Conditions 
Most settings under this heading are ​only available to users subscribed to the “QuickBooks Payroll               

Advanced” plan, unless stated otherwise.  

Manage Awards 
Users can install pre-built Modern Awards available for use. To express interest for a specific Modern                

Award not yet available, click on “Express Interest”. 

 

To install an available award, click on “Install”, then “Install” again and then “Accept”.  Detailed 

instructions on installing awards can be found here: 

https://support.yourpayroll.com.au/hc/en-au/articles/115000280086--Installing-and-Configuring-a-Pre-

Built-Award-or-Employment-Agreement  

 

You can also uninstall an award from this page by clicking on “Actions” > “Uninstall” > “Uninstall”.  

Employment Agreements 
Employment agreements combine rule sets, leave allowance templates and pay rate templates.            

Employment agreements also automate employee pay increases by updating the employee’s pay rate             

template upon a birthday event and/or anniversary date. 

 

If a Modern Award is installed, it will include the employment agreements relevant to that Award. You                 

only then need to assign the applicable agreement to an employee. Once an employment agreement is                

assigned to an employee (which is done via the employee’s Pay Run Defaults screen), the following                

settings will pre-populate: 

 

- Pay Rate Template 

- Rule Set 

- Primary Pay Category 

 

If you have not installed an Award, you can still create employment agreements. To do this, click on 

“Add a custom agreement” and follow the detailed instructions found here: 

https://support.yourpayroll.com.au/hc/en-au/articles/200432260-Employment-Agreements  
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Work Types 
Users subscribed to the “​QuickBooks Payroll Standard” plan can access work types without upgrading              

their plan. 

Work Types are used when creating timesheets or clocking on/off via the kiosk or the WorkZone app.                 

The purpose of work types is to automate any exception to an employee being paid their base rate of                   

pay.  

 

To create a work type, click on “Add” (located on the top right hand side of the screen) and complete                    

the following: 

 

- Name​ (required) 

- External Id​: If you are using an external system to manage timesheets, ​you must add the work                  

type Id/Code in this field so that the correct work type is mapped when importing the                

timesheets into the pay run. Otherwise, this field can be left blank.  

- Automatically enabled for​: Only tick any of these checkboxes if you want staff classified as any                

of those employment types to automatically have access to the work type. Otherwise, if these               

are not ticked, you can manage this on an individual basis by ticking the work type for an                  

employee via the ‘Work Types’ screen from the employee’s profile. 

- Work maps to​: This setting is required and what you tick depends on the reason for the work                  

type:  

➢ Employee’s Primary Pay Category​: Use this setting if you want the employee to be paid               

at their base rate of pay. For example, you could create a work type called ‘Ordinary                

Hours’ that is to be used for all timesheets created for Monday through Friday. 

➢ Pay Category​: Use this setting if you want the employee to be paid a different pay                

category to their primary pay category. For example, you could create a work type called               

‘Sunday’ that is then mapped to a ‘Sunday’ pay category and used for all timesheets               

created for Sundays. The purpose of doing this would be to differentiate the higher              

hourly rate paid on Sundays. 

➢ Leave Category​: Use this setting if the employee is creating a timesheet for a leave day.                

For example, you could create a work type called ‘Rostered Day Off’ that is then mapped                

to the ‘Rostered Day Off’ leave category. This will ensure that leave balances are              

updated correctly when processing the timesheets in the pay run. 

➢ Leave Category (Apply to pay run as leave accrual)​: Use this setting if the employee is                

creating a timesheet for hours worked that are to be converted to accrued leave. For               

example, you could create a work type called ‘Accrue RDO’ that is then mapped to the                

‘Rostered Day Off’ leave category and the checkbox to accrue leave is ticked. The result               

here will be that the employee is not paid for the hours worked on this timesheet but                 

rather the number of hours are automatically added to the employee’s RDO balance. 

➢ None (Shift Condition)​: Use this setting if you need to satisfy more than 1 exception to a                 

timesheet. Because you can only assign one work type to a timesheet, using a shift               
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condition will allow you to assign a work type as well as a shift condition. For example, if                  

an employee works on a Sunday they are to be paid the Sunday rate and a meal                 

allowance. When creating the timesheet, you would assign the ‘Sunday’ work type and             

then add the shift condition ‘Meal Allowance’, as follows: 

 

A short code is required as part of setting up the shift condition. The code will be viewed                  

by employees so ensure it is something easily recognisable.  

Rule Sets 
If a Modern Award is installed, it will include the rule sets relevant to that Award. You can unlock the                    

rule set to see each rule created in detail. To do this, go to “Manage Awards” > click on “Actions” >                     

select “Unlock Rules” > accept the conditions and click on “Unlock”.  

 

If you have not installed an Award, you can still create tailored rule sets. To do this, click on “Add” 

(located on the top right hand side). Depending on your scenarios will determine how your rules should 

be created. Detailed instructions on creating rules can be found here: 

https://yourpayroll.zendesk.com/hc/en-gb/articles/200346875-Pay-Condition-Rules 
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The following video shows examples of how to create rules: 

https://support.yourpayroll.com.au/hc/en-au/articles/207687906-VIDEO-Pay-Condition-Rule-Set
-Recipes-Video-Series  

Pay Rate Templates 
Users subscribed to the “​QuickBooks Payroll Standard” plan can create pay rate templates without              

upgrading their plan. For this to work effectively however, we suggest work types are also created to                 

then map the correct pay categories accordingly if timesheets are being used and imported into the pay                 

run. 

 
If a Modern Award is installed, it will include the pay rate templates relevant to that Award. From an                   

employee perspective, the pay rate template will automatically be assigned once you assign an              

employment agreement to that employee.  

 

Pay rate templates enable you to create pre-defined sets of pay rates which can then be applied to new                   

and existing employees. To create a pay rate template, click on “Add” (located on the top right hand side                   

of the screen) and complete the following: 

 

- Name​: Enter a name for the pay rate template 

- Primary Pay Category​: Assign a primary pay category from the drop down list. 

- Super thresholds​: the legislated default amounts are entered here but you can override this by               

ticking the “Override” checkbox. 

- Pay Rates​: There are 3 parts to this: (a) under the “Enabled” column, deselect any pay                

categories that are not applicable to this template; (b) for those pay categories that are relevant,                

enter the rate of pay under the “Rate” column and (c) the super rates specified under the ‘Super                  

Rate” column are auto-populated based on the settings of the relevant pay category. If you want                

to change the super rate, tick “Override” and enter the new super rate. 

- Click “Save”. 

Leave Allowance Templates 
Users subscribed to the “​QuickBooks Payroll Standard” plan can create leave allowance templates             

without upgrading their plan. Additionally, there are three system generated leave allowance templates             

that can be used and/or amended to suit business requirements (Permanent Leave - No Loading,               

Permanent Leave - With Loading and Casual Leave) 

 

The purpose of leave allowance templates is to, once assigned to an employee, automate the               

entitlements and accrual of leave for an employee when processed in a pay run.  

 

To create a leave allowance template, click on “Add” (located on the top right hand side of the screen)                   

and complete the following: 
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- Template Name​: ​Enter a name for the leave allowance template 

- Enabled Leave Categories​: Select the leave categories you want to activate for employees who              

will be attached to this template. Employees can then access these leave categories when              

requesting leave. 

- Leave Allowances​: All leave categories that are set to accrue automatically will appear in this               

section. If the leave category is not applicable for this template, enter ‘0’ in the “Units” field. For                  

those categories that are applicable, enter the units and unit type. If the leave is subject to leave                  

loading (for eg annual leave) enter the loading amount in that field. Clicking the calculator icon                

will allow you to work out the units that should be entered: 

 

  

- Click “Save”.   

Timesheet Rounding 
There are 2 setup options here - Shifts and Rostered Shifts. Both options can be used in tandem. 

 

For the “Shifts” settings, users subscribed to the “​QuickBooks Payroll Standard” plan can apply these               

settings without upgrading their plan. 

 

Shifts 

Here you can configure rounding settings required for timesheets that have been created by employees.  

For example, using the setting “Start Time” = Round to the nearest 5 minutes. An employee’s timesheet                 
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has a start time of 8.43am - the rounding settings will change the timesheet start time to 8.45am.                  

Alternatively, if the employee’s timesheet has a start time of 8.41am - the rounding settings will change                 

the timesheet start time to 8.40am. 

 

Rostered Shifts 
 

Here you can configure the start and end times of timesheets created via the kiosk to match the                  

rostered start and end time if they are within the specified threshold.  

 

For example, using the setting “Round up to rostered start time within” = 20 minutes. An employee has                  

been rostered to start work at 8.30am however clocks on at the work site at 8.15am. As this start time is                     

within 20 minutes of their rostered shift time, the rounding settings will change the timesheet start time                 

to 8.30am.  

Setting up Employees 
You can set up employees into the payroll system using various methods: 

 

1. Employee Wizard 

2. Import employees 

3. Employee Self Setup  

1. Employee Wizard 

To manually add an employee, click on “Add Employee”. You will then be taken through the employee                 

wizard to complete the essential information required to set up an employee so they can then be                 

included in the pay run. The employee wizard does not run you through ALL employee information. As                 

stated above, the wizard is designed as a ‘shortcut’ to setting up an employee easily and quickly.  

 

A few notes regarding this process: 

 

● Employee Notifications (Screen 1)​: This setting determines what method of notification the            

employee will receive for pay slips and/or rostering. You can then tailor the rostering              

notifications within the employee file. If you choose ‘email’ you must enter an email address for                

the employee, otherwise it will not let you progress to the next screen. This also applies if you                  

choose ‘sms’ as the notification type in that you must enter a mobile number for the employee. 

● Turn on self-service for this employee? (Screen 1)​: If you select ‘Yes’, you must also have an                 

email address entered for the employee. The employee will then be sent emails with              

instructions on logging into the employee portal once you have completed the wizard. If you               

select ‘No’, you can always activate self service for the employee at another time.  
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● Primary Pay Category (Screen 2)​: You can select any of the system created or your own pay                 

categories. Bear in mind that if you choose the system generated ‘Casual Ordinary Hours’ pay               

category, this incorporates a 25% loading in the settings and so the employee’s hourly rate of                

pay should be entered exclusive of the 25% loading. 

● Timesheets (Screen 2)​: If you select ‘Do not use timesheets’, the employee will be set up as                 

“auto-pay”, that is, the pay run will automatically mark them to be paid based on the standard                 

hours entered on this screen. You can switch off the auto-pay setting in the employee’s Pay Run                 

Defaults screen.  

● Bank Details (Screen 3)​: Bank details or BPAY details must be entered otherwise you will not be                 

able to progress to the next screen and complete the employee wizard. (unless the payment               

option cash/cheque is selected) 

● Super Fund (Screen 3)​: You do not need to complete the super details at this stage in order to                   

complete the wizard. However, if you enter a super fund you MUST also enter a membership                

number. 

● Tax File Number (Screen 4)​: This field is compulsory. If the employee has not provided you with                 

a TFN for whatever reason, select from the scenarios listed on the screen.   

● Lodge Tax File Declaration with ATO (Screen 4)​: If you have enabled electronic lodgement, you               

are able to electronically submit the employee’s Tax File Declaration to the ATO as part of the                 

employee wizard. 

 

Once you have completed the employee wizard, you will be able to go into the employee’s file and                  

complete all other details. 

 

2. Import Employees 
The import functionality allows you to add employees in bulk. You can access the import via 2 ways: 

 

1. Click on the arrow to the right of “Add Employee” on the payroll dashboard and then click on                  

“Import Employees”. There are a      

selection of methods from the dropdown to import employees. If you do not use any of the                 

external systems listed, choose the “Standard Format file upload”. To obtain a template of this               

format, click on “Export” located on the top right hand side of the screen. Select “Empty                

Template” from the dropdown and then click on “Download”. 

2. Go to “Payroll Settings” > “Date Extracts” (located under the Business Management menu).             

Select “Empty Template” from the dropdown and then click on “Download”. 

 

Once you have downloaded the template spreadsheet, you can commence filling in the employee 

details. Detailed instructions on how to complete this import can be found here: 

https://yourpayroll.zendesk.com/hc/en-gb/articles/200143414-Employee-Import-via-CSV 
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To import the completed spreadsheet, click on the arrow to the right of “Add Employee” on the payroll                  

dashboard and then click on “Import Employees”. Import option = “Standard Format file upload”. Click               

on “Select File...” and upload the document from your browser. Click on “Confirm upload?”. The import                

will commence and, once complete, will receive confirmation if successful, or be advised of any errors or                 

warnings. 

 

Additionally, you can use the template employee file to update existing employee data in bulk. To do                 

this, click on the arrow to the right of “Add Employee” on the payroll dashboard and then click on                   

“Export Employees”. Regarding the ​Data Type dropdown, you can choose from either “Template with              

employee data” or “Template with employee data (including terminated employees)”, depending on            

your scenario. Then click on “Download”. Make the relevant updates on the spreadsheet and import               

back into the payroll. 

3. Employee Self Setup 
In short, Employee Self Setup puts the onus on the employee to complete their details online, all of                  

which is then stored in the payroll. 

 

The full access user is only required to enter minimal information and then the employee receives an                 

email with a link to complete the rest. 

 

To access Employee Self Setup, click on the arrow to the right of “Add Employee” on the payroll                  

dashboard and then click on “Start Employee Self Setup”. 

A context panel will appear. Complete the following information: 

 

1. First Name (required) 

2. Surname (required) 

3. Email Address (required) 

4. Mobile Number (this is not required but ​STRONGLY recommended to add. The reason is that               

when the employee completes the tax file declaration they will receive an sms with a unique                

code (to meet the ATO’s authentication requirements). The employee will then need to enter              

this code in one of the fields as part of their onboarding process. If you do not enter a mobile                    

number, you will need to rely on the employee to do this and if they don’t they will not receive                    
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the code. This will result in an inability to lodge the employee’s tax file declaration online. 

5. Select if you want employees to enter their qualifications as part of the self setup process. N.B. if                  

there is a warning icon next to this option it means you have not created qualifications as part of                   

your payroll settings and so will not be able to select this option until you do so. 

 

6. Select if you want employees to enter their emergency contact details as part of the self setup                 

process. 

7. Click “Save”. 

 

The employee will now receive an email with a link to commence their self setup process. You can, at                   

any time, see an update of what the employee has completed from the payroll dashboard. 

 

Summary notification of employees in the self setup process: 

 

Send follow up email to employee by clicking on envelope icon to complete process: 

 

Icons coloured in green indicate they have been completed: 

 

You can complete the employee’s employment details at any time during the process: 

 

Employee Profile 
You can access a ‘complete’ employee’s profile at any time by clicking on the employee’s name from the                  

payroll dashboard.  

 

A few notes regarding the employee profile:  

 

- Anniversary Date (‘Details’ screen)​: This field is relevant if the employee’s anniversary date             

53 



varies from their start date and where their rate of pay is based on such anniversary. For                 

example, an apprentice who commenced their apprenticeship on 1/4/18 but started with the             

company on 18/10/18. In this scenario, the employee’s anniversary date should be entered as              

1/4/18. If this field is left blank, the system will take the employee’s start date as their                 

anniversary date. 

- Tags ​(‘Details’ screen)​: If you have installed any Awards or have created rules through the pay                

conditions engine that use tags, this field is where you would add the tag for that employee.                 

Additionally, tags can be set up against employees to then report on and use to create employee                 

groups. 

- ATO Lodgement Status (‘Tax File Declaration’ screen)​: From here you are able to electronically              

lodge an individual employee’s tax file declaration with the ATO or alternatively mark as being               

lodged manually.   

- Standard Work Week (‘Pay Run Defaults’ screen)​: From here, you can use the advanced setting               

to set up an employee’s standard work. Click on “Advanced” and this will activate the schedule                

table. Click on “Edit” and you can then start entering the employee’s standard hours (as               

start/finish times or hours): 

 

- Auto-Pay Setting (‘Pay Run Defaults’ screen)​: From the below screenshot, you can see the              

setting “Pay these earnings by default in a pay run”. If this setting is ticked, the employee’s                 

hours per week will appear in the pay run by default. If an employee is to be paid by timesheet,                    

ensure this option is unticked. If you see the warning message (shown below) this means that                

you have select to pay the employee based on timesheets as well as auto-pay. This should be                 

corrected ASAP to ensure the employee is paid correctly. 

 

- Rostering/Pay Slip Notifications (‘Pay Run Defaults’ screen)​: You can change/update how you            

want an employee to be notified of their pay slip and, separately, rostered shifts. 

- Super Thresholds (‘Pay Run Defaults’ screen)​: The system automatically sets the thresholds for             

when an employee should start earning super in a calendar month and when super should be                

capped on a quarterly basis (as per legislation). If you want to override any of these default                 

settings, tick the “Override” box and enter the new threshold amount.  

- Payroll Tax (‘Pay Run Defaults’ screen)​: If an employee is exempt from payroll tax, you need to                 

tick this checkbox so that the Payroll Tax report provides accurate data. For reporting purposes,               

the employee will be deemed to be payroll tax exempt from the day you tick the checkbox.                 

Additionally, they will no longer be payroll tax exempt when you untick the checkbox.  
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- Additional Earnings Lines (‘Pay Rates’ screen)​: Here you can set up any additional payment the               

employee is entitled to on an ongoing basis (that will not be captured via timesheets) that will                 

then automatically appear in the pay run. An example is where an employee receives an annual                

$10,000 car allowance and is paid on a monthly basis: 

 

Alternatively, you can set up additional earnings lines to split auto-pay employee hours between              

locations. For example, a full time employee works equally between 2 locations and their              

earnings should be split accordingly: 

 

N.B. If you choose the above setup, ensure that the “Pay these earnings by default in a pay                  

run” setting is unticked on the employee’s Pay Run Defaults screen - otherwise 76 hours will                

appear in the weekly pay run.  

- Locations (‘Locations’ screen)​: From here, you can tick additional locations (outside of the             

employee’s primary location which is set up from the Pay Run Defaults screen) that the               

employee can work. The employee will then be able to select these additional locations when               

creating timesheets, submitting expenses, etc. 

- Recurring Deductions, Tax Adjustments, Expenses, etc (‘Pay Run Inclusions’ screen)​: From 

here, you can set up recurring pay run inclusions for an employee and also set a start and expiry 

date (if applicable) for each inclusion. This will then flow into the pay run automatically so you 

don’t have to worry about manually adding to the pay run each time. Detailed instructions on 

setup can be found here: 

https://yourpayroll.zendesk.com/hc/en-gb/articles/115000225063-Setting-up-Pay-Run-In
clusions 

- Employee Portal Access (‘Employee Portal Access’ screen)​: You can set up or revoke an              

individual employee’s access from this screen. 

- Kiosk Details (‘Time and Attendance’ screen)​: You can grant or revoke an individual employee’s              

kiosk access from this screen. You can also change the employee’s PIN on their behalf. 
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Miscellaneous 

My Notifications 
 
To access your notification settings, click on “Manage Employees” (pay run dashboard) > Notifications. 

The full suite of notifications you can select are as follows: 
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Depending on your subscription plan and configured settings, you may not see all of these notification                

types. Tick each notification setting you want to receive. Additionally, you can choose to receive               

‘reminder’ emails for certain scenarios on a daily basis  or select day. 

 

Remember to click on “Save” before you close the screen.  

Calendar Feeds 
You can set up calendar feeds for approved leave, pay runs and birthdays. Once configured, a unique                 

link is provided to you that can then be used to import into your calendar application. This link can also                    

be communicated to staff so that they also have access to ​leave, pay run and/or birthday information.                 

You can choose to set up only one or all of these events as a calendar feed. 

 

To set up a calendar feed, click on “Add” (located on the top right hand side of the screen) and then                     

complete the following: 

 

● Name​: Enter the name of the calendar feed. Make sure to name it something the employees will                 

understand. 

● Event Type​: Select from either approved leave; pay runs; or birthdays. Each event type requires               

it’s own calendar feed. 

● Employee Group​: This field appears for Birthday and Approved Leave event types. If you want to                

restrict the data contained in this feed for a select group of employees ensure an employee                

group has been created and then select that employee group from the dropdown list. If the feed                 

to contain all employee data, then select ‘None’. 

● Date Type/Pay Schedule​: This field appears for Pay Run event types. ​If you have more than one                 

pay schedule, you can tailor the feed for each pay schedule. Additionally, select whether you               

want the feed to be based off pay date or pay period end date. 

● Click on “Save”.  
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